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3DSlicer

Slicer is a freely available open-source
platform for segmentation, registration
and 3D visualization of medical imaging

data

Powerful processing. Streamlined interface, Extensible platform.,

Slicer is a multi-institutional effort
supported by the National Institute of

Health.




Translational research

An open-source environment An end-user application
for software developers for clinical investigators
and scientists

3D Slicer: an open-source platform for
translating innovative algorithms into
clinical research applications



3DSlicer History

Image Courtesy of the CSAIL, MIT

1997 Slicer started as a
research project between the
Surgical Planning Lab (Harvard)
and the CSAIL (MIT)



3DSlicer History

I Powerful processing. ‘1 Streamlined interface. Extensible platform.
I\ .\ 1 - ~ T

1997: Slicer started as a
research project between the
Surgical Planning Lab (Harvard)
and the CSAIL (MIT)

2014: Multi-institution effort to
share the latest advances in

Image analysis with clinicians
and scientists



A Multi-institution Effort
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- Infrastructure grants fund the platform
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the application packages



Slicer Is Open

Madrid 2012

* Open Science

Open Source
+

Open Data
+

Open Community

Courtesy R. Kikinis



Slicer Open Community

« 80 authorized developers
contributing to the source

code of Slicer

* QOver 700 subscribers on
Slicer user and Slicer

developer mailing list




Nov.2011-March.2014
Downloads

@ Slicer4 download stats

3iDSlicer
Date range Region Country
@ Nov 28,2011 -Sep 24,2014 ~ Northern America (30744) United States (26119)
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Slicer

Get Slicer 4.

Pre-complied binaries

Windows

System requirements
Siow reguites 1GB of RAM absoiune m
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3D Slicer in practice

* Slicer is open-source

* Slicer works on Windows, Linux,

T and Mac
e Sliceris distributed under a
BSD-style license agreement
N X with no restriction on use

versions 10.5 fLeopard). 10.6 fSnow Leoperd), and 10.7 (Lionk and a variety of Linux dstributions
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Slicer Training

* Hands-on training
workshops at national
and international venues

 >3.000 clinicians,
clinical researchers
and scientists trained
since 2005




3D Visualization of the Anatomy

Following this tutorial,
you will be able to load
and visualize volumes
within Slicer4, and to
interact in 3D with

structural images and
models of the anatomy.




3D Slicer Version4

& 3D Slicer 4.3.1-2014-06-22 - i = ™

File Edit View Help

Modules: &) Welcome to Slicer

<

- $O @ s B t-B ™R +-@°

@x 1K

@ Slicer \\\

Welcome

[, Load DICOM Data [ Load Data The Welcome module is the
i# Customize Slicer € pownload Sample Data d efa u It Sta rt_u p mOd u Ie

» Feedback

» About

HRrREN 15: 0.000mm | ~ Y & R: 0.000mm | G I A: 0.000mm

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

» Data Probe
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3D Slicer Version4

B 3D Siicer 431-2014-06-22 AT —— =
File Edit View Help
Modules: ., |2 Welcome to Siicer il PO e t-18 W R4+ @®
@ ® ; 1
B osiicer Each module of Slicer includes a series
of tabs, which gives access to different
Welcome functionalities
[Gitsy Load DICOM Data ooy Load
 Custonize Sicer waasamperata  Click on the arrow symbol to display
S—— the content of each tab
M R 15: 0.000mm L y R: 0.000m:n = G A: 0.000mm

3D Slicer is a free open source software platform for medical image processing
and 3D visualization of image data. This module contains some basic
information and useful links to get you started using Slicer. For more
information, please visit our website http://www.slicer.org.

3D Slicer is distributed under a BSD-style license; for details about the
contribution and software license agreement, please see the 3D Slicer Software
License Agreement. This software has been designed for research purposes
only and has not been reviewed or approved by the Food and Drug
Administration, or by any other agency.

» The Main Window

» Loading and Saving

» Data Probe




& D Slicer 4.3.1-2014-06

3D Slicer Version4

Modules: £ Welcome to Slicer | = @ Q & &5 Z =] $ ~ 5o ‘;b- v B A

@® 1K

'{zj Slicer

[ Load DICOM Data [y Load Data The Main Window tab contains
i Costonsen Sho @ Dowriond Sanple Dot information on the basic organization of
b Feedback Slicer’s user interface

» About

 The Main Window Scroll down to see all the contents

R 1S: 0.000mm | ~ Y & R: 0.000mm & G [

A: 0.000mm

File Menu —[F s o — Toolbar

GUI Panel —|* — 3D Viewer

I Slice Viewers

Data Probe —| I — Message Bar

The basic organization of Slicer's user interface (UI) is shown above. This
module's content will reference these following components, labeled in the
figure:

File Menu:
Contains basic load and save functionality, access to application
settings, Tcl and Python interfaces for developers, help and
mechanisms for users to provide feedback.

Toolbar: v

» Data Probe




Slicer User Interface

3D Slicer 4.3.1-2014-06-22

. - — Toolbar

B User Interface (Ul) panel of |

Welcome / the Slicer Welcome Module

=& Load DICOM Data 5oy Load Data
i Customize Slicer € Download Sample Data
v Feedback

_ Share your stories with us and let us know about how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every 3D Viewer *

submission wil be carefully read.

See more at http://goo.gl/6BvcHm.

= G - | A: -21.000mm

>
About R: 0.000mm

» The Main Window
» Loading and Saving
» Display

» Mouse & Keyboard
v Data Probe: C:/Users/aminp/Desktop/S...te/slicer4minute.mrml

wmr

— Data Probe ' )

2D anatomical viewers



Slicer4

IR 3DVisualizationData -olEN : 3D Slicer 43.1-2014-06-22 = =
“ Home Share View L7 File Edit View HE"D
4 FERd ~ H - - a |
- Moveto~ X Delete ~ = pAA)  [ocw odules: &1 Welcome to Slicer 4 1 3 0 » v »
& Cut k ) > Select all o Modul  Wel to Sl 4 =
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y o~ | = - —
Copy 5 Copy to =0 Rename fl‘ollec;;r Proofﬁles & S8 |nvert selection @® 1
‘b\ 3DSlicer
€ - 1 » 3DVisualizationData » v ¢ Search 3DVisualizationData yel .d
Fav Name ‘ Date modified Type Size P~
S s e Welcome
BC | .DS_Store 6 DS_STORE File 7KB
%3 C ||| MR-head.nrrd 6 014 3:33 NRRD File 6,453 KB - ‘
R [Gissas Load DICOM Data Ea= Load Data
> Customize Slicer & Download Sample Data
7@ On
8 Thi x Féedback
mC f
C ‘ _ Share your stories with us and let us know about how
C || 3D Slicer has enabled your research. J
s ‘ s
B N —
S We are always interested in improving 3D Slicer, and every AN
BV submission wil be carefully read. - -
G L . . . See more at http://goo.gl/6BvcHm. : = Y ' [ |R:0.000mm |B G [N JA: 0.000mm
Browse to the 3DVisulizationData —

""file and select MR-head.nrrd S
On your diSk » Loading and Saving

» Display

¥ Data Probe

Drag and drop into Slicer

-

3 items 1item selected 6.30 MB == =




m Home Share

Copy

g2V

€l Ne

3 items

/
4 Cut

W] Copy path

- 1 » 3DVisualizationData v ¢

Name
3DHeadData

| .DS_Store
|| MR-head.nrrd

Click on OK to load the
dataset into Slicer

1 item selected 6.30 MB

3DVisualizationData -

S I . I
= B 3D Slicer 4.3.1-2014-06-22

Bt | Ko~ | [ B Slicer automatically opens - @t -

4

[Copyto~ =0Rename  New

“  ""the ‘Add data into the scene’ .
wincﬁlew

Date modified

T

Add data into the scene ?

6/24/2014 3:33 |Choose Directory to Add||Choose File(s) to Add

Show Options

v File Description
¥ C:/Users/aminp/Desktop/3DVisualizationData/MR-head.nrrd Volume s

- Y & R: 0.000mm [¥ G ¢

L Reset @OK

» Display

¥ Data Probe

A: 0.000mm



Loading a volume

% 3D Slicer 4.3.1-2014-06-2
File Edit View Help

Modules: £\ Welcome to Slicer i il O' @ QO & &5 Z -~ J= &'

il = K
@® 18

The axial, sagittal and coronal views appear
in the 2D viewers

b 3DSlicer

4

[Gistay Load DICOM Data [5ac Load Data
{#: Customize Slicer G Download Sample Data
» Feedback ‘
» About

) R: -2.145mm

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard
¥ Data Probe

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

©
Fle Edt View Help

&& Modules: . | E\Welcome to Slcer s - QO 4~ fa Se . I

@® 5
@ 3DSlicer
v

Welcome

[

| =% Load DICOM Data || oacy Load Data |
‘ 4 Customize Slicer || @ Download Sample Data |
'~ Feedback

_ Share your stories with us and let us know about how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every
submission will be carefully read.

See more at http://goo.gl/6BvcHm.

> About

' The Main Window

\ » Loading and Saving

\ » Display

> Mouse & Keyboard
'~ Data Probe

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

©
Fle Edt View Help
&& Modules: . | E\Welcome to Slcer s - QO 4~ fa e | 4~ A
® &1 [E Conventional
= [l Conventional Widescreen
*% 3DSlicer . -
@ B Conventional Quantitative
- B Four-Up
We I CO m e B Four-Up Quantitative
[ Dual 3D
. - & Triple 3D
| [Gizsay Load DICOM Data || iy Load Data | 3D only
‘ 4 Customize Slicer H @ Download Sample Data ‘ [l One-Up Quantitative
'~ Feedback @ Yelow slice only
[ Green slice only
_ Share your stories with us and let us know about how Tabbed 3D

" 3D Slicer has enabled your research.

[E] Tabbed slice

We are always interested in improving 3D Slicer, and every B compare 4

submission will be carefully read. [ Compare Widescreen »
See more at http://goo.gl/6BvcHm. FH Ccompare Grid »
> About e [ Three over three
— / [ Three Over Three Quantitative
> The Main Window P 4 B Four over four
» Loading and Saving I B Two over Two
: [T side by side

> Display I 7 B8 Four by three slice
b Mourn # Kovhaord A B Four by two slice

~=Click on the Red slice only B Three by thee sk
option *)

m

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

> 3D Slicer 4.3.1-2014-06-22 - o I E3
File Edit View Help
Modules: £\ Welcome to Slicer |- Bt~ fa 5 -8 e
@ = [IREE 15: -10.714mm
{D Slicer
4
=& Load DICOM Data 5oy Load Data
i Customize Slicer € Download Sample Dita
v Feedback

_ Share your stories with us and let us know abofit how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, agl every
submission wil be carefully read.

See more at http://goo.gl/6BvcHm.

» About

» The Main Window
» Loading and Saving
» Display

» Mouse & Keyboard -
¥ Data Praohe

Position your mouse over the
. pin icon to display the slice
" viewer toolbar




Loading a volume

> 3D Slicer 4.3.1-2014-06-22
Fle Edit View Help
B@ | Modules: £\ Welcome to Slicer 3| - Bt~ fa S = K
e = CIRIEE
("\ » & £ v Axial + | MR-head
(3 Slicer
=4
=& Load DICOM Data 5oy Load Data
i Customize Slicer € Download Samplg/Data
v Feedback

_ Share your stories with us and let us knofft about how
3D Slicer has enabled your research.

We are always interested in improving 3D er, and every
submission will be carefully read.

See more at http://goo.gl/6BfFcHm.
» About

» The Main Window
» Loading and Saving
» Display

» Mouse & Keyboard -
v Data Probe

- Once the slice viewer toolbar
" is displayed, click on the “>>”




Loading a volume

(> 3D Slicer 4.3.1-2014-06-22 - o I E3
Fle Edit View Help
@ Modules: £\ Welcome to Slicer $| - E $ ~ fa 5o v G A
B ® gt 1 0
{,\ < & 4 v|Axial $ <, B g @
[ Sl
o oo & = None S
Welcome 1 | 2eme :
] - | B | MR-head s
=& Load DICOM Data 5oy Load Data
i Customize Slicer € Download Sample Data
v Feedback

_ Share your stories with us and let us know about how
3D Slicer has enabled your research.

We _are ahvave interected in_imnravina 2D Slicer  and  evens

“"This menu will appear once
»athe “>>" button is pressed

The Main Window

v

v

Loading and Saving

» Display

v

Mouse & Keyboard -
v Data Probe

-




Loading a volume

& 3D Slicer 4.3.1-2014-06-22 - g
File Edit View Help
B@ |Modules: &) Welcome to Slicer = E - o b = K
e ® LIREE 1s: -10.714mm
« & £ v|Axial T EE o @3 @
(B DSlicer > = Ng * 1x1 view i
1x2 view F
Welcome 12 ] =28 e :
& z m M 1x4 view N

1x6 view S

Gz Load DICOM Data [y Load Data D8 view
Cuctomize Sii o oad S —— 2x2 view
3 s .
*: Customize Slicer € Download Sample Data 3x3 view
v Feedback

Custom *

_ Share your stories with us and let us know about how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every
submission will be carefully read.

See more at http://goo.gl/6BvcHm.

v

About

v

The Main Window

v

Loading and Saving

v

Display

v

Mouse & Keyboard
v Dar-\ Deabha

Click on the Lightbox
. menu and choose the

E

° option “6x6 view”




Loading a volume

£ 3D Slicer 43.1-2014-06-22 - &
File Edit View Help
[ocu] Modules £\ Welcome to Slicer $| - E $ ~ e e - E A
@& R [ 1s: -10.714mm

rb\ sl
=4
Gz Load DICOM Data o= Load Data
> Customize Slicer € Download Sample Data

-Slicer displays 36
consecutive images of
the DICOM volume.
Use the red slice slider
'to browse through the
.data

» Display

» Mouse & Keyboard
v Data Probe

-




Loading a volume

2 3D Slicer 43.1-2014-06-22 - 8w
File Edit View Help
B@ |Modules: &\ Welcome to Slicer - ﬁ t - o 5o = K
@ ® o
Conventional Widescreen
fm )Slicer . -
= LAY Conventional Quantitative
We | come B Four-Up Quantitative
Dual 3D
S - Triple 3D
[Eicony Load DICOM Data [oaay Load Data
i Customize Slicer € Download Sample Data { 4" [l One-Up Quantitative
> J [0 Red slice only
¥ Feedback & Yelow slice only
{ [ Green slice only
_ Share your stories with us and let us know about ho; L[
3D Slicer has enabled your research. . Tabbed 3D
| Tabbed slice
We are always interested in improving 3D Slicer, and gvery . = Compare
submission wil be carefully read. B Compare Widescreen
See more at http://goo.gl/6BvcHm. T B Compare Grid
(NI
» About b EE Three over three

L
'.L! HH Three Over Three Quantitative
2 M Four over four

v

The Main Window

» Loading and Saving FH Two over Two
1[0 Side by side
: /
Display | Y ‘ﬁ Four by three slice

v

Mouse & Keyboard -
v Data Probe

. Click on the Slicer layout i |con’
. and select Conventional
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File Edit View Help

&& |Modules: . | & Welcome to Slicer

@ 3DSlicer
7

\ W, W A PR,

Position your arrow again on
the pin icon of the red
viewer, select the Lightbox

“'menu and change it back to

“1x1 view”

We are always interested in improving 3 icer, and every
submission wil be carefully read.
See more at http://goo.gl/6BvcHm.

> About

> The Main Window

\ » Loading and Saving

\ » Display

> Mouse & Keyboard

'~ Data Probe

-

@

@B\

@

Loading a volume

3D Slicer 4.3.1-2014-06-22 - 0

) t-E w4 @P
c

1x1 view

1x2 view
1x3 view
1x4 view

1x6 view &
1x8 view ‘
2x2 view »
3x3 view
* 6x6 view
Custom » &

3D Data Loading and VisualizaBon

Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

o) X
File Edit View Help
&& |Modules: . | & Welcome to Slicer s - Q O t~ Ra Ra | 4~ A
e® B18

@ 3DSlicer
v

Position your arrow again on
“the pin icon of the red
“viewer and click on the links
“icon to link all three viewers

_ Share your stories with us and let W know about how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, af, every
submission wil be carefully read.

See more at http://goo.gl/6BvcHm.
> About

> The Main Window 9 £ "Axial v l oo P 3«

\ » Loading and Saving u @ ‘:E‘ & ‘None

T [0.00 [2] B

(& ‘ = |§l MR-head
7 4 & &

L“sa R
2 e

<«

4

O

‘ None

> Mouse & Keyboard
'~ Data Probe |

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

w X
File Edit View Help
&& |Modules: . | & Welcome to Slicer s wm Q ) B t- @ % f |+~ A
@® 5

@ 3DSlicer
7

Welcome ﬂ

“Once the icons are linked,
..click on the eye icon to

display all 3 anatomical
slices in the 3D V|ewer

We aic awvays wicicstcu i nnpiuvily oo oiecl, cvery
submission will be carefully read
See more at http://goo.gl/6BvcHm.

> About

" Fee

‘((H ‘

||| | & ‘ S ‘None :
H [0.00 [*] BB ‘None
‘ v|l MR-head

> The Main Window

\ » Loading and Saving

\ » Display

> Mouse & Keyboard -
'~ Data Probe |

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

&& |Modules: . | & Welcome to Slicer s - Q O $ ~ Ao Fo | 4~ A
1€

@®
@ 3DSlicer
>

Welcome

|  [=Ess Load DICOM Data || 5oy Load Data |
‘ 4 Customize Slicer ‘ ‘ @ Download Sample Data ‘
v Feedback

All three anatomical slices
Share . o
“wos@re shown in the 3D viewer

We are always interested in improving 3D Slicer, and every
submission wil be carefully read.

See more at http://goo.gl/6BvcHm.
> About

> The Main Window

\ » Loading and Saving u

\ » Display

> Mouse & Keyboard o~
'~ Data Probe

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a volume

File Edit View Help

@ Modules: | B\ Welcome to Slicer s - Q O t - fa S b v g A
@®

.@ 3DSlicer

Welcome

|  [=Ess Load DICOM Data || 5oy Load Data

‘ 4 Customize Slicer ‘ @ Download Sample Data

Use the left mouse button to
rotate the camera and the right
mouse button to zoom in and out

submission wil be carefully read.

See more at http://goo.gl/6BvcHm.
> About [

> The Main Window |

\ » Loading and Saving B

\ » Display

\ » Mouse & Keyboard -
'~ Data Probe

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Close the scene

Edit View Help

& Add Data CtrHO  elcome to Slicer = QO QO t v B fe Rl 4~ A
& DICOM ® N
B Download Sample Data
& Save Ctr+S
"% Close Scene Ctrl+W
Exit
\ Load DICOM Data || oy Nata

‘ @ Customize Slicer || € Download Saw‘

" eedbac - .
et To close the scene, click on $N
_ Share your stories with us and let us know & o
waem o File and select Close Scene % 8

v

We are always interested in improving 3D Slicer, and every
submission wil be carefully read.

See more at http://goo.gl/6BvcHm.

> About

> The Main Window

\ » Loading and Saving

\ » Display

\ » Mouse & Keyboard ~
'~ Data Probe

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Exit Slicer

358 Edit View Help

& Add Data CrHO  elcome to Slicer = QO QO t~ fm Fo |-~ 1C3 @
& pICOM =

Download Sample Data

& Save Ctr+S

To exit Slicer, click on File

7@ Close Scene Ctrl+-W
TS and select Exit

[Gissay Load DICOM Data || 5oy Load Data
4 Customize Slicer ‘ @ Download Sample Data
v Feedback |

_ Share your stories with us and let us know about how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every
submission wil be carefully read.

See more at http://goo.gl/6BvcHm.

> About [

> The Main Window |

\ » Loading and Saving

\ » Display

\ » Mouse & Keyboard ~
'~ Data Probe

-

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Part 2

3D Visualization of
Surface Models of
the Brain

aaaaaaaaaa ing and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loading a Scene

3D Slicer 4.3.1-2014-06-22 ==
Home  Share  View ~ @) Fle Edt View Hep
< Y = > + B V'S - p -
S [ d Cut JhMoveto~ | X Delete - ) LE ), & Hselecan @ Modules: . | &) Welcome to Slicer sl= QO QO t v @& » | e v »
= [8=) Copy path 1 = } Select none =
C Paste > = N P rt E
= ’ 2] cut 5 Copy to =Ji Rename fo[edv:r rop'e e o DD Invert selection ®
0 New Open
- 4 3DSlicer
'/\(3\1 - 1 . » 3DVisualizationData » 3DHeadData v ¢ Search 3DHeadData pel v
X Ea Name Date modified Type Size W I
BC | .3DHeadScene.mrml.swp 6/24/2014 3:33 PM SWP File 164 KB e CO I I l e
@ C | ].DSStore 6/24/20143:33PM  DS_STORE File 7KB
$C i [ 3DHeadScene 6/24/2014 3:33 PM Slicer supported file 142 KB 7S -
LR | grayscalenrd 6/24/20143:33PM  NRRD File | [Gisiy Load DICOM Data | [y Load Data |
|| hemispheric_white§matter.vtk 6/24/20143:33PM  VTKFile ‘ ‘Q Customize Slicer ‘ 9 Download Sample Data ‘
% On | | left_eyeballvtk 6/24/20143:33PM  VTK File
[Ra| Master Scene View 6/24/20143:33PM  PNG image ! —
N Thi ic chi 6/24/2014 233 PM  VTK File > Feed |
1 Thi | | optic_chiasm.vtk 6/24/2014 3:33 PM VTK File
mC | | optic_nerve Lvtk 6/24/2014 PM  VTKFile
FIC ] optic_nerve Rtk 6/24/20143:33PM  VTKFile j _ Share your stories with us and let us know about how
BT[] optic_tract Lytk 6/24/20143:33PM  VTK File = 3D Siicer has enabled your research.
U N | ] optic_tract_Rvtk 6/24/20143:33PM  VTKFile
E1P | right_eyeball.vtk 6/24/20143:33PM  VTK File We are ab.va_ys interested in improving 3D Slicer, and every
BV [ Skinvik 6/24/2014333PM VK File submission will be carefully read.
o || skull_bone.vtk 6/24/20143:33PM  VTKFile See more at http://aoo.al/6BvcHm.
e T M NSO = % R .c00om
— » & Ax v‘Axial s |None E
| » The Main Window
D d drop the fil
rag an rop e I e \ » Loading and Saving
: " into Sli
3DHeadScene.mrml’ into Slicer ooy

| ¥ Data Probe

15items  1item selected 141 KB =)

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Loaqunﬁg a Scene

| [ = | 3DHeadData 3D Slicer 4.3.1-2014-06-22 = =
Home  Share  View ~ @ Fie Edt View Hebp
oy ) = S . 2, 4 " . 3
= % Move to ~ 7< Delete ~ l = J E EE seectel @ Modules: aWelcome to Slicer - \) ‘) E » '47 v E >
= — S - Select none '
Co e - E Ne Properties
[ hortcut L Copy to =4 Rename fo[dv:r pv : & DD Invert selection ®
* . . B spsiicer
((::\ v 1 » 3DVisualizationData » 3DHeadData v ¢ Search 3DHeadData P N " 4
-
v Fau Name Date modified Type Size

BIC | | .3DHeadScenemrml.swp
8cC __| .DS_Store
22

33 C [ 3DHeadScene

E R | ] grayscalenrrd

|Choose Directory to Add||Choose Fie(s) to Add Show Options

v File Description
¥| C:/Users/aminp/Desktop/3DVisualizationData/3DHeadData/3DHeadScene.mrml MRML Scene %

|| hemispheric_white_matter.vtk

@ On | | left_eyeballvtk 6/
|Rs Master Scene View

1% Thi | | optic_chiasm.vtk 6/24/2
mC | | optic_nerve_Lvtk
“/C || optic_nerve_Ruwvtk

& C | | optic_tract_Lvtk 6/
W N || optic_tract Rtk
= P || right_eyeball.vtk 6,
BV || Skinvtk
%- L || skull_bonevtk 6/24/2
G Ne o =8

» & Ax v‘Axial s |None s

% Reset

Slicer automatically opens the
‘Add data into the scene’ window.
Click on OK to load the scene file.

15items  1item selected 141 KB
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Loading the Slicer Scene x

/5 3D Slicer 4.3.1-2014-06-22 - - — =
Fle Edt View Help
Modules: . | &\ Welcome to Slicer sl QO PO @& 5 2 Bl @ % ol A
o K

@ 3DSlicer
Welcome

l Load DICOM Data || LoadData |
H @ Download Sample Data ‘

[»)

1 R: 14.062mm

’ 4 Customize Slicer

v Feedback

_ Share your stories with us and let us know about how
3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every
submission wil be carefully read.

See more at http://goo.gl/6BvcHm.

v

x A

| ¥ Data Probe: C:/Users/F/Desktop/Slice...Data/3DHeadScene.mrml \

d

- A 3D surface model of the head, an
° 2D anatomical slices appear in the
Slicer Viewer

NA-MIC ARR 2012-2014
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Loading the Slicer Scene

& 3D Slicer 43.1-2014-06-22 " Al Modules T T e e s, o e

Fle Edt View Help

N i Annotations
@ Modules: . | & pata 7. t v @B S Ebv

< DataStore ——

& DpICOM
@ 3DSlicer 7 Edit
4 or

+ @

] Load DICOM Data

1 R: 14.062mm

’ 4 Customize Slicer

v Feedback

_ Share your stories v
3D Slicer has enable

We are always interested in
submission will be carefully read.

See more at http

Registration

Segmentation »
Quantification 4
Diffusion
IGT
Fitering 4 \ ‘
Surface Models » .

- Select the Modules menu and select
Models

x A

'~ Data Probe: C:/Users/F/D

‘ Developer Tools 4 |

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



Models Module

3D Slicer 4.4.0-2014-11-06

SEt- B M - @A

ga %3 Modules: | © Models = Q019 O @ =

ex i
@ 3DSlicer

» Help & Acknowledgement

Z &

Scene
= hemispheric_white_matter.vtk
= left_eyeball.vtk
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
» optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk

- ol A bl

Puddddddd

3888888888

» Display

» Clipping

~ Data Probe: /L

puj

Slice Annotations:| =

L
F
B

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

86006 3D Slicer 4.4.0-2014-11-06

ga & & Modules: . ©Models 1m0 09O @ » - e+ @@

@ 3DSlicer

» Help & Acknowledgement

" . -POSItION the cursor over the pin icon NV

- left eyeball ko

‘ze=vin to reveal the slice menu and click on
_L'mthe eye icon to reveal the axial slice

= skull_bone.vtk

» Information

» Display

» Clipping

~ Data Probe: /L j Data/3DF mrml

Slice Annotations: =«

L
F
B

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

&3 Modules: | © Models = Q. PO @ i 2 & 4~ Ao fo, -@e
[
A
:@ 3DSlicer

» Help & Acknowledgement

Include Fib: Scroll to... o H H H
T e =~ Notice the axial slice through the 3D
= left_eyeball.vtk N 1.00
= optic_chiasm.vtk 1.00
- S erve Lok = model of the head
o v 100
- rig ht_eyebal .‘_1-0?‘
el boneik e
Information
Display
Clipping

Once the axial slice is

displayed in the 3D viewer,

click on Skin.vtk in the list of
.-3D scenes

Slice Annotations: | =

L
F
B

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

ia £a 'Modules: | © Models

@ 3DSlicer

» Help & A

nclude Fibers Scroll to... B3
= hemispheric_white_matter.vtk 1
= left_eyeball.vtk w1
= optic_chiasm.vtk 1
= optic_nerve_L.vtk 1
= optic_nerve_R.vtk 1.4
= optic_tract_L.vtk 1
= optic_tract_R.vtk 1
- rl%hl_e eball.vtk 1
£ d
1

» skull_bone.vtk

» Information

~ Display

~ Visibility

Visible: v
View: All

Clip:
Slice Intersections Visible:
Slice Intersections Thickness:|1 px

entation

#ftddce

Opacity:
Edge Visibility:

Edge Color: m #000000 "

» Lighting
» Material

» Scalars

» Clipping

..Scroll down the Display tab and
s=|ocate the “Color” tab. Lower the

. Opacity to a transparent level,
~_around 0.30

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

3D Slicer 4.4.0-2014-11-06

ga # %a |Modules: . |© Models I QO PO & s 2k ~EIt-E R +-I@@
15

2®
!D; 3DSlicer
4

» Help & Acknowledgement

%

Include Fibers Scroll to...

= hemispheric_white_matter.vtk

= left_eyeball.vtk

= optic_chiasm.vtk

= optic_nerve_L.vtk

= optic_nerve_R.vtk

= optic_tract_L.vtk

= optic_tract_R.vtk

- rIﬂhLe eball.vtk | |
Ski

873588355 ¢ |

= skull_bone.vtk

» Information

~ Display | ] = R: 14.062mm
~ Visibility
Visible: v
View: All i
Clip:
Slice Intersections Visible:
Slice Intersections Ihlckness:h px =
» Representation
~ Color
Color: ( #ffddce
Opacity: P (03072
Edge Visibility:
Edge Color: | u #000000

» Lighting
» Material

» Scalars

» Clipping

-..Notice the skin has become almost
*-fully transparent

: /

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014




3D Visualization

3D Slicer 4.4.0-2014-11-06

& |Modules: . [© Models = Q0019 @ @ & <«
EE] ’
!l= 3DSlicer
7
» Help & A
Include Fibers Scroll to... ;HE

= hemispheric_white_matter.vtk
= left_eyeball.vtk

= optic_chiasm.vtk

= optic_nerve_L.vtk

= optic_nerve_R.vtk

= optic_tract_L.vtk

= optic_tract_R.vtk

= right_eyeball.vtk

= Skin.vtk

u
Moo
88888888

s

» Information

~ Display = =+ R: 14.062mm
~ Visibility -
Visible:
View:
Clip:
Slice Intersections {isible:

Slice Intersections TRickness: |1 px B

v
All

» Representation
~ Color

Color: \ #FHHE
Opacity: (1002
Edge Visibility: \

Edge Color: m #000000

» Lighting

» Material

» Scalars

» Clipping \

“Scroll back up to the 3D scenes
menu and select skull_bone.vtk

5 /

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

8 00 3D Slicer 4.4.0-2014-11-06
& |Modules: . [© Models 1= 0019 © @ \/\-E » t- B8Rl +-@e

!b; 30Slicer
s

» Help & Acknowledgement

Include Fibers Scroll to... E
= hemispheric_white_matter.vtk 1.00 [+
= left_eyeball.vtk W 1.00
= optic_chiasm.vtk 1.00
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00

= optic_tract_R.vtk .00
» right_eyeball.vtk :
n.vtk

» Information

~ Display

~ Visibility

Visible:

View: Al
Clip:

Slice Intersections Visible:

Slice Inter T [1p

» Representation
~ Color

Color: #tfftt

Opacity: 1/1.00
Edge Visibility:
Edge Color: u #000000

» Lighting

» Material

» Scalars

» Clipping \

Turn off its visibility by unchecking
vmthe Visibility option and notice the

s~pONEe disappearing from the 3D

. view of the head )

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

000 3D Slicer 4.4.0-2014-11-06

ga 2 & Modules: . [© Models " Q0P @i 2k CEItVE WA+ @@
e @IS

> Help & Acknowledgement

Include Fibers Scroll to...

= hemispheric_white_matter.vtk
= left_eyeball.vtk
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
» right_eyeball.vtk
Skin.vtk

[ |
RS
83885333t |

S5

> Information

v Display
~ Visibility
Visible:
View: Al
Clip:
Slice Intersections Visible:
Slice Tl [1px

» Representation

~ Color

Color: | #ffffE

Opacity: [1.00]2
Edge Visibility:

Edge Color: | L]

» Lighting
» Material

» Scalars

 Clipping

Position your mouse over the pin icon
.in the coronal slice view and select the
‘eye icon to reveal the coronal slice in
:the 3D view

|4 L

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

8 00 3D Slicer 4.4.0-2014-11-06

s £a Modules: . [© Models s s & > g~ o Fa | 4 v ce

@ 3DSlicer
4

[» Help & Acknowledgement

Include Fibers . Scroll to...

= hemispheric_white_matter.vtk

» left_eyeball.vtk

= optic_chiasm.vtk

= optic_nerve_L.vtk

= optic_nerve_R.vtk

= optic_tract_L.vtk

= optic_tract_R.vtk

= right_eyeball.vtk .

= Skin.vtk 0.30
___c skullbonevtk _______________________________N100 B

[» Information

| ~ Display
~ Visibility
Visible:
View: All >
Clip:
Slice Intersections Visible:
Slice Intersections Thickness: |1 px S

R: 14.062mm

» Representation

~ Color

Color: ( #EEE |
Opacity: 2[1.00;)
Edge Visibility:

Edge Color: | m #000000 |

» Lighting

» Material

» Scalars

[» Clipping

The coronal slice is shown in the
3D viewer

| ~ Data Probe: /Users/spujol/Downloads/...Data/3DHeadScene.mrml

Slice Annotations: | =

omnr

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

8 00 3D Slicer 4.4.0-2014-11-06

£ |Modules: . [ Models =0 O » t - o e+

@ 30Slicer

» Help & Acknowledgement

Include Fibers Scroll to...

Scroll up and select the 3D scene
hemispheric_white matter.vtk,
then check off the option for Clip
under the Visibility tab

3lie

= left_eyeball.vtk

= optic_chiasm.vtk

= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk

= optic_tract_R.vtk

» right_eyeball.vtk

= Skin.vtk

< skull_bone.vtk

YOOI |

owoooo009
OCO0O000O0O00OO0,

» Information

~ Display
~ Visibility
Visible:

R: 14.062mm

Slice Intersections Thickness: |1 px

» Representation

~ Color

Color: #tfftt
Opacity:

Edge Visibility:
Edge Color: m #000000

» Lighting

» Material

» Scalars LGH
» & | v Coronal +|grayscale

» Clipping

~ Data Probe: /1 puj ...Data/3D}

Slice Annotations: | =

wmr

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

8 006 3D Slicer 4.4.0-2014-11-06
& Modules: . |© Models = Q0P & i 2 & t - B A -ge
1

EE)

Q 3DSlicer

» Help & Acknowledgement

¢
¢]

nclude Fibers Scroll to...

-_hemispheric_white_matter.vtk K 2
= left_eyeball.vtk
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk
< skull_bone.vtk

YOI |

owooooo0D
0566666060

» Information J

~ Display | = e R: 14.062mm
~ Visibility
Visible: v

View: All o
Clip: v

Slice Intersections Visible:

Slice T 1 px =
» Representation

~ Color

Color: | #EffEE |
Opacity: 7/1.00 2]
Edge Visibility:

Edge Color: | u #000000 J
» Lighting

» Material

» Scalars

v Clipping

Red Slice Clipping: *— Positive +— Negative

Yellow Slice Clipping: * Positive * - Negative
Green Slice Clipping: % Positive @ t— Negative

Data Probe: /L Data/3D}

mrml|

~ Scroll down and find the tab

* Clipping, and check off the options
for Green Slice Clipping and

3D Data Loading and VisualizaBon Negative Space NA-MIC ARR 2012-2014




3D Visualization

8 006 3D Slicer 4.4.0-2014-11-06

& Modules: . |© Models " QO I9P O @ & i MY -@e

@ 3DSlicer

e The optic chiasm appears

nclude Fibers

= smmein the 3D viewer

= optic_chiasm.vtk

= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
= optic_tract_R.vtk 1.00
= right_eyeball.vtk 1 1.00
= Skin.vtk 0.30
< skull_bone.vtk 1.00

» Information

v Display

~ Visibility

Visible: v
View: Al >
Clip: 4

Slice Intersections Visible:

Slice T 1 px =

R: 14.062mm

» Representation

~ Color

Color: #tfftt

Opacity: 111,00
Edge Visibility:

Edge Color: u #000000

» Lighting

» Material

» Scalars

v Clipping
Clipping Type: 7‘ Union @ (@ Intersection
Red Slice Clipping: *— Positive Negative

Yellow Slice Clipping: * Positive Negative

wo

¢ Green Slice Clipping: % Positive @ t— Negative

v Data Probe: /1 Data/3Dk e.mrml|

puj

Slice Annotations: | = |

wnr

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



8 00

3D Visualization

3D Slicer 4.4.0-2014-11-06

& |Modules:

@ 3DSlicer

© Models s = O. PO e i 2 &

o= [H1

Bt B w @R

O

» Help & Acknowledgement

Include Fibers

- y k
= optic_chiasm.vtk
= optic_nerve_L.vtk
= optic_nerve_R.vtk
= optic_tract_L.vtk
= optic_tract_R.vtk
= right_eyeball.vtk
= Skin.vtk

< skull_bone.vtk

* Information

Lower the Opacity of

hemispheric_white matter.vtk
~

2 Y 5.

~ ’F‘ ;

~ Display \ ' . R: 14.062mm
~ Visibility A ¢

Visible: v 1 w»

View: All - . &

Clip: ~ ¥

Slice Intersections Visible: % > \/

Slice Intersections Thickness: 1 px = ! >

» Representation

~ Color

Color:
Opacity:

Edge Visibility:
Edge Color:

» Lighting

» Material

» Scalars

~ Clipping
Clipping Type:
Red Slice Clipping:
Yellow Slice Clipping:
¥ Green Slice Clipping:

~ Data Probe: /1

0.40 3

m #000000

]G pe———
» & | # v Coronal ¢ grayscale

) Union Intersection

*— Positive t— Negative
* Positive * Negative
% Positive @ t— Negative ~

...Data/3D}

Slice Annotations: | =

wnr

mrml

3D Data Loading and VisualizaBon

Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014



3D Visualization

8 00 3D Slicer 4.4.0-2014-11-06
&3 Modules: | © Models = QO PO @@ & 2 & »EIL- Ra R, -3 e

@ 3DSlicer

» Help & Acknowledgement

Include Fibers

me—=o:Check the option Slice Intersections Visible

= left_eyeball.vtk

= optic_chiasm.vtk 1.00
= optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
= optic_tract_R.vtk 1.00
= right_eyeball.vtk I 1.00
= Skin.vtk 0.30
~ skull_bone.vtk 1.00

» Information

~ Display R: 14.062mm
~ Visibility

Visible: <4

View: All v

Clip:

Slice Intersections Visible: v

Slice Intersections Thickness: 1 px 5

» Representation

~ Color

Color: #ttiE

Opacity: 0.40
Edge Visibility:

Edge Color: m #000000

» Lighting

» Material

» Scalars

2 G@# e A .34.500mm
» 9| & v\ Coronal \grayscale

~ Clipping
Clipping Type: & Union @ @ Intersection
Red Slice Clipping: t- Positive t Negative
Yellow Slice Clipping: * Positive * - Negative
&

¥ Green Slice Clipping: Positive

t— Negative

~ Data Probe: /L j Data/3DHeadScene.mrml

Puj

Slice Annotations: | =

wnr

3D Data Loading and VisualizaBon Sonia Pujol, Ph.D. NA-MIC ARR 2012-2014
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& |Modules: - [© Models

{:\ Slicer

4

» Help & Acknowledgement

Include Fibers

3

left_eyeball.vtk
optic_chiasm.vtk
optic_nerve_L.vtk
optic_nerve_R.vtk
optic_tract_L.vtk
optic_tract_R.vtk
right_eyeball.vtk
Skin.vtk
skull_bone.vtk

49999999

» Information

~ Display

~ Visibility

Visible: v
View: All
Clip:

Slice Intersections Visible: 4
Slice Intersections Thickness: 1 px
» Representation

~ Color

Color:
Opacity:

Edge Visibility:
Edge Color:

» Lighting
» Material
» Scalars
~ Clipping
Clipping Type: Union
Red Slice Clipping: t- Positive
Yellow Slice Clipping: Positive
¥ Green Slice Clipping: £ Positive

~=>The intersection of the white matter
_surface with the 2D anatomical
> slices are shown in the 2D viewers

Slice Ani

Scroll to...

u #000000

®

3D Visualization

3D Slicer 4.4.0-2014-11-06

-ale

a® P [ R ———————— 57 {8mm

R: 14.062mm

G
» @ | # v Coronal

+ | grayscale :

Intersection
Negative
Negative -

Negative |~




00

& |Modules: - [© Models

(D Slicer

4

» Help & Acknowledgement

Include Fibers

3

left_eyeball.vtk
optic_chiasm.vtk
optic_nerve_L.vtk
optic_nerve_R.vtk
optic_tract_L.vtk
optic_tract_R.vtk
right_eyeball.vtk
Skin.vtk
skull_bone.vtk

49999999

» Information

~ Display

~ Visibility

Visible: v
View: All
Clip:

Slice Intersections Visible: 4
Slice Intersections Thickness: 1 px
» Representation

~ Color

Color:
Opacity:

Edge Visibility:
Edge Color:

» Lighting
» Material
» Scalars
~ Clipping
Clipping Type: Union
Red Slice Clipping: t- Positive
Yellow Slice Clipping: Positive
¥ Gre

_Position your cursor over the pin
s«jcon in the coronal slice view and
: unselect the eye icon

Scroll to... (||

u #000000

3D Visualization

3D Slicer 4.4.0-2014-11-06

-ale

S: -27.188mm

R: 14.062mm

G
» @ |# v Coronal 3 grayscale

® Intersection
t— Negative e

Negative -



3D Visualization

I3l Conventional

[E Conventional Widescreen

/& 3D Slicer 4.3.1-2014-06-22
Fle Edt View Help

Modules:

@ 3DSlicer
Y

» Help & Acknowledgement

ot [E Conventional Quantitative

| Four-Up
Four-Up Quantitative
B Dual 3D
& Triple 3D
3D only
[l One-Up Quantitative

[»]

Include Fbers . Scroll to... ‘ {r H S
. [ Red slice only
-1 Scene = i
hemispheric_white_matter.vtk ) [ Yelow slice only 3
# left_eyeball.vtk B 100 3 Green slice only ‘ ——————R: 14.062mm
# optic_chiasm.vtk 1.00 | -
# optic_nerve_L.vtk 1.00 [ Tabbed 3D
# optic_nerve_R.vtk 1.00 E Tabbed slice
# optic_tract_L.vtk 1.00 P ~ B com
. { i 3 : pare
# optic_tract_R.vtk 1.00 ‘ \ 7o '
# right_eyeball.vtk B 100 = | " B Compare Widescreen

' Information

/ f Sl Three over three
v Display : '

~ Visbilty / |

v Data Probe: C:/Users/F/Desl«op/SIice...Data/3DHeadS<ﬂe.mrmI |

e

®_ Lx " Coronal | grayscale

M Four over four

B Two over Two

[T Side by side
- & Four by three slce
M Four by two slice
Bl Three by three slice

L

Click on the Slicer Layout icon
and select Conventional

— -
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3D Visualization

° :
File Edit View Help
ga 2 & [Modues: . [@ Models =0 Q019 @ @ & 2 t-18 e +-1@@

@ 3DSlicer

| » Help & Acknowledgement

Include Fibers ‘ . Scroll to...

< ispheric_white_matter.vtk

# left_eyebal.vtk [ |
# optic_chiasm.vtk

# optic_nerve_L.vtk

# optic_nerve_R.vtk

# optic_tract_L.vtk

# optic_tract_R.vtk

# right_eyeball.vtk [ |
#* Skin.vtk

< skul_bone.vtk

> Information

> Display

| » Clipping

¥ Data Probe: C:/Users/amhp/Desktop/3...Data/BDHeadScie.mrml]

; Position your cursor over the pin
= jcon in the 3D viewer to display the

~ 3D control windows. Select the
A (Anterior) view of the 3D models
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ﬁé.rﬁiépheric_whue_matler.vtk

left_eyeball.vik
optic_chiasm.vtk
optic_nerve_L.vtk
optic_nerve_R.vtk
optic_tract_L.vtk
optic_tract_R.vtk
right_eyeball. vtk
Skin.vtk
skull_bone.vtk
rayscale

eneViewToplevelHierarchyNode1

Default Scene Cameral
Default Scene Camera2
Default Scene Camera3
Default Scene Camerad
Default Scene Cameras
Default Scene Camera6
Axial

Sagittal

Coronal

Master Scene View
Default Scene Camera7
Default Scene Camera
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Saving a Scene

[ x
Edt View Help
%2 Add Data CrHO  fiodels 1= 0019 O @ 7 4~ e Fo |~ E3 @

& DICOM o= [FIE

B Download Sample Data

Ctr+S

Recently Loaded
%8 Close Scene

. hemispheric_white_. 1atter.vtk
» left_eyebal.vtk

# optic_chiasm.vtk
# optic_nerve_L.vtk
# optic_nerve_R.vtk
# optic_tract_L.vtk
# optic_tract_R.vtk
# right_eyeball.vtk
#* Skin.vtk

< skul_bone.vtk

N 4
=Y @ =——= - R:14.062nm

[ » Information

\
|
> Display ‘ ]
\
\

> Clpping

¥ Data Probe: C:/Users/aminp/Desktop/3...D&a/BDHeadScene.mrml]

Click on File and select Save
or press Ctri+S
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Saving a Scene

& 3D Slicer 4.3.1-2014-06-22 =g
File Edit View Help
@ Modules: | @ Models s - c. QY O @ i 2z t - @ R Y e v [ o

@®

Q 3DSlicer
w

® O 06 th Save Scene and Unsaved Data
\ » Help & Acknowledgement - - -
CrEEEE .
Include Fibers Scrol HH %‘ Show options
I~ File Name File Format <]
v f&i—cevcifs'\';tk - 3DHeadScenelmrml ' MRML Scene (.mrml) + | P /Users/spujol/workshop/
. Zﬁiiizzzxz—kﬁt hemispheric_white_matter.vtk Poly Data (.vtk) + | P /Users/spujol/workshop/
= optic_tract_L.vtk left_eyeball.vtk Poly Data (.vtk) + | 7 /Users/spujol/workshop/

# optic_tract_R.vtk

s A optic_chiasm.vtk Poly Data (.vtk) + | P /Users/spujol/workshopi
 skulbone.vik optic_nerve_L.vtk Poly Data (.vtk) + | 79 /Users/spujol/workshop/
> Information optic_nerve_R.vtk Poly Data (.vtk) s | ¥9i/Users/spujol/workshop/
> Display optic_tract_L.vtk Poly Data (.vtk) + | 79 /Users/spujol/workshop/
% Cipping optic_tract_R.vtk Poly Data (.vtk) + | 79 /Users/spujol/workshop/
[4] [ DN
| 74 Change directory for selected files | kel Save| X cancel
\ v Data Probe: C:/Users/aminp/Desktop/B...Data/BDHeadScene.mrmI\ 3 ,\"\ / ‘3:
The Save Scene and Unsaved W T
L \ 2
- Data window lists all the elements of

the slicer scene
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Saving a Scene

& 3D Slicer 4.3.1-2014-06-22 - g
File Edit View Help
E@ |Modules: . | @ Models s - Q’ QY O @ i 7 - fa R | 4~ E A
.@ 3DSlicer
e O 6 th Save Scene and Unsaved Data
» Help & Acknowledgement | (B \

Include Fibers Scroll t ’ )};‘k‘ H ?&%: H % ‘ Show Options
- Scene 7 File Name File Format [+]
"~ # left_eyebal.vtk v MyScene.mrml 'MRML Scene (.mrml) + | P9 /Users/spujol/workshop/

# optic_chiasm.vtk /
S e enve L / hemispheric_white_matter.vtk Poly Data (.vtk) 4+ | F9i/Users/spujol/workshop/
E ggg:tz;ﬁ:%;%:v}:k left_eyeball.vtk Poly Data (.vtk) : H == /Users/spujol/workshop/
. Sk optic_chiasm.vtk 'Poly Data (.vtk) 4+ | F9/Users/spujol/workshop/
« skul_bone.vtk
‘ optic_nerve_L.vtk 'Poly Data (.vtk) 4+ | 79 /Users/spujol/workshop/
» Information :
— optic_nerve_R.vtk 'Poly Data (.vtk) + | 79 /Users/spujol/workshop/
optic_tract_L.vtk 'Poly Data (.vtk) 4+ | F9/Users/spujol/workshop/
2ot optic_tract_R.vtk 'Poly Data (.vtk) + | 79 /Users/spujol/workshop/ _
K | DN
]l # Change directory for selected files H Il Save ” X Cancel
- ».n.Check the box next to the scene L R Y/ B

named 3DHeadScene.mrml and \ e P
- double click on it. :
Rename it MyNewScene.mrml

- and select Save

@
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Saving a Scene

TS

15 3D Slicer 4.3.1-2014-06-22

Edit View Hebp

1
ZAdd Data Ctr+0 llodels 2] - G' QPO @ i 2 t v @ & R, e n A
DICOM
@® 1
B Download Sample Data

& Save Cults Click on File and select Exit to close
Recently Loaded 4 . .
198 cose scene rew = MyNewScene.mrml and exit Slicer
. 4
Exit 4 ﬁ—
I —— ['1 ‘i I o
=-Scene <
< hemispheric_white_matter.vtk
# left_eyebal.vtk B 100
# optic_chiasm.vtk 1.00 B
# optic_nerve_L.vtk 1.00
# optic_nerve_R.vtk 1.00
# optic_tract_L.vtk 1.00
# optic_tract_R.vtk 1.00
# right_eyebal.vtk B 100 |

» Information

~ Display T
¥ Visibilty || | & i ¢ |grayscale ¢ » & 4 v Coronal % |grayscale %

v

7

|_ v Data Probe: C:/Users/F/Desktop/Slice...Data/3DHeadScene.mrml |

-
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Scene Restore

& 3D Slicer 4.3.1-2014-06-22
Home Share View ~ 9 Fle Edt View Help
L p=n . . N - .
= & L Moveto ~ X Delete ~ l e \ } €~ Hseieca @ Modules: . ‘L\Welcome to Slicer < ‘ - e () w O % t~- @ »
= < - A Select none - M
C Paste _ I - = N Pi rti
ey B [2] U5 Copy to =Ji Rename foledv:r ropf e X o) ul:l Invert selection ® 1
Clipboard Organize New Open Select -
*% 3DSlicer
@ ~ 41 . » 3DVisualizationData » 3DHeadData v ¢ Search 3DHeadData pel
9 Fav Name . Date modified Type Size W I z
Bl C | | .3DHeadScene.mrml.swp SWP File 164 KB e CO I I l e
8 C [ .DS Store DS_STORE File 7KB
23 C B 3DHeadScene Slicer supported file 142KB - -
% R[] grayscalenrd NRRD File 2035:¢s || | [Eisws Load DICOM Data || oy Load Data |
|| hemispheric_white_matter.vtk VTK File 6,270 KB ‘ #: Customize Slicer ‘ ‘ 9 Download Sample Data ‘
%@ On | | left_eyeball.vtk VTK File 56 KB
|Wa| Master Scene View PNG image 405 KB
v
1% Thi | & MyNewScene Slicer supported file 166 KB |~ Feedback
m C || optic_chiasm.vtk VTK File 14KB
5/ C | ] optic_nerve_L.vtk VTK File 28 KB _ Share your stories with us and let us know about how
8 C [ optic_nerve Rtk 333PM  VTKFile 29kB 3D Slicer has enabled your research.
W N [ optic_tract_Lvtk 6/24/20143:33PM  VTK File 18KB
E1P | ] optic_tract Rtk 6/24/20143:33PM  VTK File 16 KB We are always interested in improving 3D Siicer, and every
BV | right_eyeball.vtk 6/24/20143:33PM  VTK File 52KB submission wil be carefully read.
& L | | Skinwvtk 6/24/2014 3:33 PM VTK File 3,393KB See more at http: HQOO.QI{GBVCHm.
| skull_bonewtk 6/24/20143:33PM  VTKFile 4712KB " About
€ Ne oul
| » The Main Window
. .
Restart Slicer and find || > e s sang ——
£ : 0.000mm
» Displa
MyNewScene.mrml on | * o= i

yo u r CO m p ute r \ v Data Probe: C:/Users/aminp/Desktop/B...dData/MyNewScene.mrn:l\

-

16items  1item selected 165 KB
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Scene Restore

i1 (2= 3DHeadData - o
Home Share View ~ 09
=) ; & & Moveto ~ X Delete ~ L ) E:J' ‘J €~ Hselecta
(4] 721 Select none
WLy ess 2] 5 Copyto - =i Rename f’:;‘:r Propfrtles € Du Invert selection
| Org Ne Open Select
(@1 - 1 . » 3DVisualizationData » 3DHeadData v ¢ Search 3DHeadData yl
X Fav Name ’ Date modified Type Size
B C | | .3DHeadScene.mrml.swp 6/24/2014 3:33 PM SWP File 164 KB
& C | | .DS _Store 6/24/2014 3:33 PM DS_STORE File 7KB
23 C B 3DHeadScene 6/24/20143:33PM  Slicer supported file 142KB
El R ] grayscale.nrrd 6/24/2014 PM NRRD File
|_| hemispheric_white_matter.vtk 6/24/2014 3:33 PM VTK File
%@ On | | left_eyeballvtk 6/24/2014 3:33 PM VTK File
|Ra| Master Scene View 6/25/2( PNG image
- Thi B MyNewScene Slicer supported file
j C || optic_chiasm.vtk 6/24/20143:33PM  VTK File
=/ C || optic_nerve_L.vtk 6/24/2014 PM VTK File
& C || optic_nerve_Rwvtk VTK File
W& N | optic_tract_Lvtk VTK File
= P || optic_tract_Rwvtk VTK File
BV || right_eyeball.vtk /2 VTK File
%‘- L | | Skinwvtk 6/24/2014 3:33 PM VTK File
|| skull_bonevtk 6/24/2014 3:33 PM VTK File

‘\j Ne

16items  1item selected 165 KB

File Edt View Help

@ wu=Drag and drop the MyNewScene.mrml -
file that's in the 3DHeadData folder into

& the Slicer windo
Welcome B

| [EEss Load DICOM Data ||

[ﬁ Load Data ‘
|| @ Download Sample Data |

v Fégdback / |

' _ Share your stories with us and let us know about how
3D Slicer has enabled your research.

‘ 4 Customize Slicer

—J

We are always interested in improving 3D Slicer, and every
submission will be carefully read.

See more at http://goo.gl/6BvcHm.

» About

» The Main Window

» Loading and Saving

» Display

&

v Data Probe: C:/Users/aminp/Desktop/B..,dData/MyNewScene.mrml\

[ S: 0.000mm | ~

@ | R:0.000mm

3D Data Loading and VisualizaBon

Sonia Pujol, Ph.D.

NA-MIC ARR 2012-2014



Scene Restore

BI[lams=! 3DHeadData = = & 3D Slicer 4.3.1-2014-06-22
Home Share View ~ 9 File Edt View Help
= & [l Move to ~ Delete ~ | B & Hselectan 2 & Modules: . | B\ Welcome to Slicer $| - Lt~y B/ > -
=| | - § [ocu] mnm
— £+ A Select none M M
g Past - 5 v = Ni Pi rti
ey e [2] B Cepyito =d Rename 'ofd‘ﬁe’r ropf e e un Invert selection ® 1
Clipboard Organize Ne: Open Select
*% 3DSlicer
@ ~ 41 . » 3DVisualizationData » 3DHeadData v ¢ Search 3DHeadData pel .
Name ’ Date modified Type Size

0 Fav
Bl C | | 3DHeadScene.mrml.swp
@& C | | .DS_Store
33 C B 3DHeadScene

“R | grayscale.nrrd

|Choose Directory to Add||Choose File(s) to Add| Show Options

) N v File Description
| hemispheric_white_matter.vtk
G On [ ] left_eyeballvtk ¥ C:/Users/aminp/Desktop/3DVisualizationData/3DHeadData/MyNewScene.mrml |MRML Scene 3

|Wa| Master Scene View
1% Thi & MyNewScene
m C | | optic_chiasm.vtk
2/ C || optic_nerve_L.vtk
& C | | optic_nerve Rtk
W N | ] optic_tract_L.vtk
=/ P || optic_tract_Rwtk
BV || right_eyeball.vtk
@ L [ Skinvtk
|| skull_bone.vtk

ﬁ‘! Ne
# |~ R:0.000mm
| » Display
\ v Data Probe: C:/Use inp/Desktop/B...dData/MyNewScene.mrml\
D
< >
16items  1item selected 165KB =l
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1 3D Slicer 4.3.1-2014-06-22 — k. e S

Slicer4

k. Ths S EDDL B

File Edit View Help

f@ @ Modules:

.| B Welcome to Sicer

vl-OO PO %

<. t- B M S +- 18 @

@®

3DSlicer

Welcome

| [Gics Load DICOM Data || S Load Data

!

[ {8 Customize Slicer } ‘ € Download Sample Data

l

v Feedback

3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every
submission will be carefully read.

See more at http://goo.gl/6BvcHm.

_ Share your stories with us and let us know about how | |

> Ahant

Ad|

|v Data Probe: C:/Users/F/Desktop/Slice...Data/3DHeadScene.mrml l

L
F

s The 3D scene MyNewScene.mrml

appears in the viewer
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